7y)
"
O
&
)
O
e
(qv]
(V)
o
)
I
O
e
e
@)
O,
e’

Looking for schedule
variances

Document author: Andy Jessop
Produced by: Project Learning International
Limited

www.projectlearning.net

The tips and tricks below are taken from Project Mentor, the smart way
to learn Microsoft Project. For further information, please go to:

WWW.projectlearning.net/project mentor.htm

More useful tips and tricks can be found on the Project Learning blog:

www.projectknowledge.net

Related Document(s)

Filtering & grouping by schedule status
www.projectlearning.net/pdf/I1.2.pdf




Looking for schedule variances

Introduction

Planning a project is one thing; managing a project effectively is often
something completely different, and with its own set of challenges. Of the
Microsoft Project users that track actual progress against project tasks,
disappointingly few understand how to compare a planned schedule with what
actually happened. These users are probably unaware of the wealth of
information available to them, and the value they can get from correctly
interpreting that information.

These tips and tricks illustrate a number of ways that schedule comparisons
can be made, together with how the information available can be interpreted.

Background

Before replanning a project, a comparison should be made between the
project's current schedule and baseline information. A simple comparison can
determine: If any slippage has occurred; the tasks that exhibit the slippage or
the amount of slippage that exists. The project's schedule is normally
compared to the overall baseline for the plan (which is usually agreed between
the Project Manager and the Project Sponsor). The schedule can also be
compared with interim baselines to determine any changes since a previous
project update. These comparisons can be invaluable, as they can highlight
trends occurring within the project that may be missed by simply looking at a
project's critical path.
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Looking for schedule variances

Making baseline comparisons

When a project has been updated with progress, there will invariably be
differences between the current schedule and its baseline. This can be seen
most clearly within the Tracking Gantt view. In the example below, the
nonworking time from Tim Brown's resource calendar has been added for
clarity.

=l Manual Prl:ljec‘t “nunuu OO O DO T T v 63
+ Weekly meetings 100% §100% 3100% 3100% 0%  §0%  §O%  §O%
- Content 0%
Design structure
Wirits bady test . .
Set page layouts

w71

-| Exercises

Create exercizes

Test exercizes
Create contents & incex

Manual completed

==
Do 2023

The view above is indicating:
o Design structure started and finished on time. The baseline bar
and the actual bar for this task are scheduled identically.

o Write body text started on time and is split. It is scheduled to
finish very late due to a resource calendar affecting when work
upon the task can resume.

o Set page layouts is delayed because of its late-running
predecessor.

o Create exercises started early and it finished early.

o Test exercises started and finished early, well before its deadline
date.

o Create contents & index has a delayed predecessor, so it too is
delayed.

o The milestone Manual completed has not been rescheduled
because of its delayed predecessor.

If tasks were delayed beyond deadline dates, an indicator could show a warning message.
If milestones (or indeed any tasks) appear earlier than the finish of their predecessor(s), they
probably have an inflexible constraint against them. If so, a scheduling conflict probably exists.

Hints
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Looking for schedule variances

Quantifying schedule variances

Whilst a simple visual comparison is useful, there are ways to make a more
meaningful comparison between the current schedule and the baseline. Fields
within the Variance table provide this information:

e From the View menu, select Table and then select Variance:

Task Mame Start Finish Baseline Start | Baseline Finish | Start War. | Finish Yar.
=l Manual Project Feb 2 04 Mar 24 04 Feb204 Mar2304 0 days 1 day
+ Weekly meetings Feb 2 '04 Mar 22 '04 Feb 204 Mar 22 '04 0 days 0 days

-| Content Feb2'04  Mar 19'04 Feb 2 '04 Mar 11 '04 0 days 6 days
Design structure Fek 2'04 Fek 6 '04 Fek 2'04 Fek 6 '04 0 days 0 days

Write bocly text Fek 9'04 Mar 13 '04 Fek 9'04 Fek 25 '04 0 days 12 days

Set page layouts hlar 15 '04 hdar 19 '04 Mar & '04 far 11 '04 S days B days

-| Exercises Feb 11 '04 Mar 24 '04 Feb 16 "04 Mar 19 "04 -3 days 3 days
Creste exercises Feb 11'04 Feb 20'04 Feb 16 '04 Feb 27 '04 -3days -5 days

Test exercizes Feb 23'04 Feh 27 '04 har 1 '04 Mar 5 '04 -Sdays -Sdays

Create contents & index Mar 18 '04 Mar 24 '04 Mar 13 '04 Mar 19 '04 Jdays Jdays

Manual completed Mar 23 '04 Mar 23 '04 Mar 23 '04 Mar 23 '04 0 days 0 days

o If atask has a positive start variance: Its scheduled start is later
than its baseline start.

o Ifatask's start variance is a negative value: It started earlier than
its baseline.

o If atask has a positive finish variance: Its scheduled finish is later
than its baseline finish.

o If atask's finish variance is a negative value: It finished earlier than
its baseline.

e  Start variances and finish variances for summary tasks reflect their baseline performance. In the
example above the Content summary task above started on time, but is expected to finish six
days late. The Exercises summary task started three days early, but is expected to finish three
days late.

e  When tasks have a finish variance greater than their start variance, they are overrunning; they are
expected to take longer to complete than originally planned. These tasks may well have cost
variances associated with them as well.

Hints
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Looking for schedule variances

Quantifying changes to slack values

Schedule comparisons can also be made with slack values that tasks possess.
These fields can be found within the Schedule table:

e From the View menu, select Table and then select Schedule:

Task Mame Start Finizh Late Start Late Finish | Free Slack | Total Slack
= Manual Project Feh2T04 Mar24 04 Feb2 04 Mar24 04 Odays 0 days
+ Weekly meetings Feb 2 '04 Mar 22 '04 Feb 2 '04 Mar 24'04  2.75 days 2.75 days

= Content Feb 2 '04 Mar 19 ‘04 Feb 2 '04 Mar 18 ‘04 0 days -1 day
Design structure Feh 2 '04 Feh £'04 Feh 2 '04 Feh £'04 0 days 0 days

Write: body text Feh 3'04 Mar 13 '04 Feh 3'04 Mar 13 '04 0 days 0 days

Set page layouts Mar 15 '04 Mar 1904 Mar15'04 Mar 18 '04 0 days -1 day

- Exercises Feb 1104 Mar 24'04 Feb 1104 Mar 23 ‘04 0 days -1 day
Creste exercises Fek 11 '04 Feb 20'04  Feb11'04 Fek 20'04 0 days 0 days

Test exercizes Fek 23'04 Feb 27 '04  Feb 23'04 Fek 27 '04 0 days 0 days

Creste cortents & index Mar 15 '04 Mar 24 '04 Mar 17 '04 Mar 23 '04 0 days -1 day

Manual completed Mar 23 '04 Mar 2304 Mar 23'04 Mar 23 '04 0 days -1 day

o If tasks are completed or are critical: Their total slack value will be
0.

o If any tasks can be delayed without affecting the project finish date
or a task with an inflexible constraint: Their total slack value will be
positive.

o If a scheduling conflict exists: Tasks will have a negative total slack
value.

e  Where negative slack values are displayed against tasks, the sequence of tasks needs to be
g performed quicker in order to meet the project finish date or an inflexible constraint. In the
T example above, a saving of one day on EITHER Set page layouts OR Create contents & index
would be enough to bring the project back on schedule and reduce the total slack to be 0 days.
(T Project Learning International Limited
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Looking for schedule variances

Making comparisons to interim baselines

Schedule comparisons can also be made against interim baselines (plans).
This can provide a comparison with the project's schedule prior to the latest
update. In order for this to be possible, some simple procedures should be
adopted:

e Before updating the project with progress, create an interim baseline
(plan). This will copy the current schedule into the interim baseline
value:

a. From the Tools Menu, select Tracking and then select Save Baseline.

b. Set to copy the scheduled start into Start1 and the scheduled finish
into Finish1 for all tasks, confirmed with OK.

Save Baseline E|
" Save baseline
plani
Copy: ||'§tarthinisﬁ ] -
Into: |[Start1n=inish1j ~]
For:
™ Selected basks
r
r
Help oK | Cancel |

e Repeat the process before each update to the project.
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Looking for schedule variances

Once interim plans have been created, comparisons can be made against
them:

e Use the Table Definition dialog box to create custom tables that display
appropriate fields:

Table Definition in "Manual Project®

Marne: &nterim plan comparison JI_ Show in menu
Table
‘ Cuk Raow | Copy Raow | | Inserk Row | Delete Row ‘
jin}
Field Mame Align Data | Width | Title | Align Title | Header Wrapping

Marme iLeft { 31iTaskMame Left iYes
Start Right | 11! Center  iYes
Baseline Start {Right 13} Center  iYes
Start1 Right | 10! iCenter  ives
Start2 Right | 10! iCenter  iYes
Start3 Right 10 iCenter  iYes

Date Format: |DeFauIt j Row height: 1 il

¥ Lock First column
™ auto-adjust headsr row heights

Help [e]4 | Cancel |

e Create new views that contain custom bar styles to display the latest
interim baseline status compared to the current schedule:

Bar Styles §|
‘ Cuk Row | | Inserk Row | ‘
Critical ~
Tame Appearance | Show For ... Tasks R Fram To
— gormal, Critical 1: Ackual Start CompleteThrough
Marrmal, Noneritical 1;5tart Finish
Marrmal, Noneritical, Split 1i5tart Fini
Task Progre: )] Monetitical Lifckual Skart f ComplereThrough,
Inkerim 3 Marmal 1:5tart3 Finish3
Marmal, Split 1:i5tart3 Finish3
>
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Looking for schedule variances

o The bar style for baseline bars has been replaced with a bar style
for the third interim baseline (Start3 / Finish3):

= Manual Project B T e TR R e TRy w53
+ Weekly meetings 100% g 100% §100% §100% §lo%  30%  §O0%  §O%
-| Content 0%

Design structure
Write bocy text
Set page layouts

-| Exercises T w7
Create exercizes 0%
Test exercises '1 =
Create contents & index 0%
Manual completed Lygp 3523

o Where there is a variance between the 'Interim 3' bars and the
normal task bars, a slippage will have taken place as a result of the
'Interim3' update to the project (for example, Write body text, Set
page layouts and Create contents & index have all slipped).

e  Before updating a project with ANY actual progress, consider the update frequency. This will
determine when each change of status date should take place. Ensure that the project team is
aware of every status date and hence when the updates will be performed.

e (Create calculated fields to compare interim baseline values with current schedule values; for
example to determine a variance between a scheduled finish date and the 'Finish 4' field. This
would allow comparison with the project at its fourth change of status date.

e Upto 4 rows of bar styles can be displayed. This can provide a very detailed schedule
comparison (if required):

o Bar, Styles §|
£
I ‘ Cuk Raw | | Insert Row | ‘
Critical ~
arne Appearance | Show For ... Tasks Row Fram To
Interim 1 e i Mormal 2|5tartl Finish1
Interim 2 Mormal 3|5tartz Finishz
Inkerim 3 Mormal 3|5tart3 Finish3
Inkerim 4 Marmal 4 |Startd Finishd
\Inkerim S Mormal 4 |Skarts FinishS
* Milestone 1/Start Start v
£ >
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Looking for schedule variances

Adding progress lines to a Gantt chart

Another way that progress can be measured is by the addition of progress
lines to a Gantt chart. These progress lines can be used for a graphical
representation of task slippage. To apply progress lines:

a. From the Tools menu, select Tracking and then select Progress
Lines.

b. Select to show a progress line based upon the project's status date:

Progress Lines g|
Dates and Intervals l Line Styles l
v ialways display current progress line: ™ Display selected progress lines
+ At project status dat Ak current date 7
[ Display progress lines at recurring interyals
i« o [
O O O 3
r r r r
Display progress lines in relation to
[ £ |Mov2'03 J % Actual plan ™ Baseline plan
Help [o]8 | Cancel
c. Confirm with OK to display:
= Manual Project I P T ST TR SR T Ty e W 63
+ Weekly meetings 100% §100% 3 100% §100% 0%  §0%  §O0%  §O0%
= Content TP ey — 0%

Design structure R

Wirite bodhy tecdt
Set page layouts

-| Exercises N I
Creste exercises 0%
Test exercizes ‘ 1
Create contents & index

Manual completed

o The progress line for Write body text has been drawn back behind
the status date. This indicates that the task is behind schedule.

o The progress against the two summary tasks is rolled up from their
subtasks. The summary tasks are described as being ahead of

schedule.
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Looking for schedule variances

Hints

e  Multiple progress lines can be added, for example at each change of status date.
The style of progress lines can be defined within the 'Line Styles' tab of the Progress Lines dialog.

(]
Progress line display can be selected as well as cleared within the Progress Lines dialog.
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